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1. Introduction 

 
The program AdvancedReport performs automatic conversion of the data files and the 
event files of the Yokogawa recorder from the Smartdac GX, GP, DX, DXP, FX, 
DXAdvanced and MV1000 family. 
By the users own configurations it is possible to select the export file between the formats 
ASCII [csv] and Microsoft Excel freely. Additionally, it is possible to use an Excel-template.  
If the Excel template is not used, it is not necessary to install Excel on the computer. 
 
A further advantage is in the user-defined designation of the export file. Batch data, 
starting times and further characteristics for the automatic file designation can be used. 
 
For an effective conversion it is possible to activate the times of the function at different 
intervals. 
 
A condition for these functions is the presence of the data files, display data files and/or 
display event files in a folder on the Windows PC. Using the ftp client function of the 
Yokogawa recorders, it is possible to store the files on the PC. For further information 
please read operating instructions of the recorder. 
 

For updates and changes about the program, please read the info file stored in the 
installation folder or contact your Yokogawa sales team. 
 

 

 
Note: 
Please read this manual to find solutions! 
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2. Revision 

 

Date Version Reason 

06.2013 1 First creating 

11.2013 2 Update Recorder list 

01.2014 3 Update Function, Recorder list and Documentation 

02.2014 4 Update Documentation 

08.2016 5 Update Service Documentation 

12.2016 6 Update Settings chapter 

04.2017 7 Update Settings chapter 

06.2017 8 Update Excel Template without Excel 

09.2017 9 Update SmartDac Firmware R4 / Windows 10 

02.2018 10 Update Service Installation Routine 

03.2018 11 Update “Protect each sheet” 
Update Print Configuration 
Update Documentation 

12.2018 12 Add Folder Structure definition 
Update supported Recorder list 
Update Download Chapter 

08.2019 13 Add Multi Threading instance for Service. 
Add Service Status Window 

12.2019 14 Add Cell Name Format for Excel Template 
Change Excel Template implementation 

01.2020 15 Change Excel Settings 
Add Application AdvRptEnable.exe 

07.2020 16 Add manual conversion Show Detail Option 
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3. System Requirements 

 
3.1 Hardware 

 
For the documentation of the test, a paperless Data recorder is required.  The Data 
recorders listed below are supported by the Add in:   
 
 

Recorder File extension Data type 

GX10 / GP10 / GX20 / GP20 / GM10 
[without & with  /AS Pharma Option] 
www.smartdac.com 
 

.GDS 

.GEV 
Display Data 
Event Data 

DX1000 / DX1000N / DX2000  
[ DXAdvanced ] 
www.DAQStation.com 
 

.DAD 

.DAE 
Display Data 
Event Data 

DX1000 / DX2000    
[with /AS1 Pharma Option] 

.DSD 

.DSE 
Display Data 
Event Data 

DX100 / DX200 
 
 

.DDS 

.DEV 
Display Data 
Event Data 

FX1000  
 
 

.DAD 

.DAE 
Display Data 
Event Data 

MV1000 / MV2000  
[ MVAdvanced ] 
 

.DAD 

.DAE 
Display Data 
Event Data 

FX100  
 
 

.DDS 

.DEV 
Display Data 
Event Data 

DX100P / DX200P 
Pharma-Ausführung 
 

.DBD 

.DBE 
Display Data 
Event Data 

MW100 / MX100 
 
 

.MXD 

.MXC 
Data 
Combine Data 

DL850 
 

.WDF Data files 

 
 
For the analysis using a PC, the following minimum hardware requirements must be met.   
 
• Hard disk capacity:  30 MB 
• Memory:  4GB 
 

http://www.smartdac.com/
http://www.daqstation.com/
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3.2 Software 

The program AdvancedReport Version 2 is Windows based and requires therefore a 
Windows Operating System. 
 

3.3 Prerequirement 
 

- Windows .Net Framework 4 Full installation (is checked by setup) 

• http://www.microsoft.com/en-us/download/details.aspx?id=17718 
- Microsoft OFFICE .NET Framework (VSTO) installation (is checked by setup) 

• http://www.microsoft.com/en-us/download/details.aspx?id=35594 
 

 
3.4 Operating System 

 
The program has been tested on the following platforms1: 

- Windows 7 [32bit] 
- Windows 7 [64bit] 
- Windows 8 [64bit] 
- Windows 10 [32bit] 
- Windows 10 [64bit] 
- Windows Server 2008 
- Windows Server 2012 
- Windows Server 2012R2 
- Windows Server 2016 

 
3.5 Additional Software 

 
For using an Excel Template check the following requirements: 
 

- Export only   → Microsoft Excel is NOT required.  
- Chart / Trend function  → Microsoft Excel is NOT required.  
- Print function   → Microsoft Excel is required.  
- VBA function   → Microsoft Excel is required.  

 
For using the Template Creator the following Microsoft Excel Version is necessary: 

 
- Microsoft Excel 2010 [32Bit]  
- Microsoft Excel 2013 [32Bit] 
- Microsoft Excel 2016 [32Bit] 
- Microsoft Excel 365 [32Bit] 

 
For creating the Report, there is also an older or newer installed version possible. 
 

 
1 Microsoft Windows and Excel are a registered trademarks or trademarks of Microsoft Corporation in the United States 

and/or other countries 

http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/details.aspx?id=35594
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4. Download 

 
Load the latest version of our solution from the following web Page: 
 
http://www.AdvancedTools.de 
 
Check there for “Version 2” and “AdvancedReport Version 2”. 
 

5. Software Function 

 
The software will be creating automatically a report from all supported data files into an 
Excel Base file or a Text base file. 
 
Check the following diagram to find out the function of the software. 
 

Recorder  → PC FTP Server → one folder / folder structure (Subfolder) → generate 
Report into folder (Subfolder) → move data file into folder (Subfolder) 

 

 
 
 
 
 

http://www.advancedtools.de/
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6. AdvancedReport: Start the program  

The program starts in the illustration that follows. 
The window consists of two parts. The left part consists of the navigation bar with the 
menu options: 

• Home/Main 

• Configuration of the report(s) 

• Create TUSReport (separate license) 

• Manual conversion 

• Automatic conversion 

• Program settings 

• Event Report and Error Handling 

• Service Status Window 

• Close Program 

• Information 
The appropriate dialogues are indicated in the right part. The explanations to the individual 
adjustment possibilities are specified on the following pages. 
 

 
Start the program 
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7. Configuration of the Report  

 
On the register sheet “program settings” the following settings are made: 
 

 
Report settings 

 
7.1 Button 
 

7.1.1 Add/Delete Button  
 

 
With this Version it is possible to add more than one Report. With this Button it can be add 
or delete the report. More than one Report is only available with the Multi Batch Option. 
 

7.1.2 Button Save/Undo 
 

After all changes at the configuration the attitudes over the Button “save” in the 
file AdvancedReport.ini must be deposited.  
With the Button “undo” can be indicated the last stored attitudes again. 
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7.1.3 Print / Print Preview Project configuration 
 

 Print the configuration on one sheet. 
 

 
Print Preview 
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7.2 Project Active Checkbox 
 
To activate or deactivate a Project, check ore uncheck this checkbox. 
An active Project will be mark with a Green Dot at the Project list. 
 

    
Active Project 

  
Deactivate Project  

 
 

Selected Project 

 
If a project deactivate, the auto scan routine will be ignore this project. Only a manual 
conversion is possible.  
 
 
7.3 Folder 
 
The “source folder” defines the place on the hard disk, where the recorder files are stored. 
The “target folder” marks the place, in which the report files are stored.  
The “target folder original files” marks the place, in which the original binary source files 
are stored. Additionally, the “target folder” and the “target folder original files” can be the 
same. 
 
All subfolders in the “source folder” are scanned. If appropriate files in a subfolder are 
found, all of the files are exported into the same target folder structure.  
 
The listings can be found easily n the computer by hitting the button right beside the input 
field. 
 
With the Button “$x” it is possible to set user specific name with the following individual 
elements 
 

Element name Configuration 

Original file name $O 

Batch name $B 

Serial number $S 

Los number (batch) $L 

Day $DD 

Month $MM 

Year (two digit) $YY 

Year (four digit) $YYYY 

Hour $HH 

Minute $mm 

Second $SS 

serial-number/year of the file $C 

1. Group name $1 

2. Group name $2 
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3. Group name $3 

4. Group name $4 

1. Batch comment $C1 

2. Batch comment $C2 

3. Batch comment $C3 

 
The file name can be individually arranged by joining the individual elements. Also firm 
indication can be inserted. Please you pay attention to use only windows conformer 
indications for the name designation. 
 

 

 
NOTE: 
The “source folder” and “target folder” may not be identical! 
 

 
 
 
7.4 Source file handling modes 
 
It is possible to go around the entire conversion and only shift the data files. During the 
shift renaming of the files is likewise possible. 
 
It is possible to set a handling mode for the source files. 
There are three possible modes: 
 

1. Move source file: This mode moves the reported source file into the target folder for 
binary files. 

 
2. Delete source file: This mode deletes the source file after the report file is created. 

The file is not deleted into the Recycle Bin!!! 
 
3. Indicates source file: This mode adds the filename after the report file is created into 

a text file. The file is not moved into another folder. To report the file a second time, 
the manual mode must be used. 
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7.5 Attitudes file format 
 
On register sheet “file format” the following attitudes are made: 
 

 
File format 

 
 

7.5.1 Export format 
 
- Table-oriented ASCII format 
The files are converted into the CSV format. As separators the indications settings on the 
computer are used. 
 

 
Text Base CSV Format 
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- Excel Format with collecting template file 
The file and the memory place must be defined in the line Excel template. In the collecting 
template file it is possible; already further analysis to deposit diagrams and statistics data.  
If no file is indicated, a new empty Excel file is provided.  

 
Full supported Microsoft Excel 

 

 

 

Note: 
1. This function is slower due to co-operation with Excel. 
2. For this function Ms-Excel on the computer IS necessary. 
3. Ms-Excel up to Version 2003 administers maximally 65535 

lines. This restriction can lead with files with many measuring 
points to problems. Use a temporal delimitation if necessary. 

 

 
- Excel Format with collecting template file (EXCEL LIMIT) 
The file and the memory place must be defined in the line Excel template. In the collecting 
template file it is necessary; already further analysis to deposit diagrams and statistics 
data.  

 
Limit Excel Template; only Excel 2017 and 2010 Format with Extension *.xlsx allowed! 

 

 

Note: 
This function is has limited Microsoft Excel support. 
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7.5.2 Excel Macro 

 
After checking the Checkbox a VBA Macro will be run at the end of the report. The Name 
of the makro is ‘AdvancedReport’. 
 

 
User defined Macro. Find in VBA Editor of Excel (Excel Hotkey: ALT + F11) 

 
7.5.3 Use Excel Template and Excel VBS Macro within the service 

 
To convert the Data files within the Excel Template you must create a Folder 
under Windows 7 and Newer. 
 
IMPORTANT: Create the following Folder! 
 

64-bit %WinDir%\SysWOW64\config\systemprofile\Desktop 
 
And 
 
%WinDir%\System32\config\systemprofile\Desktop  

32-bit %WinDir%\System32\config\systemprofile\Desktop 

 

 

 
ATTESION IMPOTANT: 
It is only possible to create this folder as a user with administrative Rights! 

 
 
Start MS Excel to change this setting within the Service Running User!!  
 

 

 
ATTESION IMPOTANT: 
Start MS Excel to change this setting within the Service Running User!! 

 
Another method to enable macros in a file is via the Microsoft Office Backstage view, 
the view that appears after you click the File tab, when the yellow Message Bar 
appears. 

1. Click the File tab. 
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2. In the Security Warning area, click Enable Content. 
3. Under Enable All Content, click Always enable this document's active content. 

The file becomes a trusted document. 
 

The following image is an example of the Enable Content options. 

 
 
Macro settings are located in the Trust Center. However, if you work in an organization, 
the system administrator might have changed the default settings to prevent anyone 
from changing settings.  
Important: When you change your macro settings in the Trust Center, they are changed 
only for the Office program that you are currently using. The macro settings are not 
changed for all your Office programs. 

1. Click the File tab. 
2. Click Options. 
3. Click Trust Center, and then click Trust Center Settings. 

 
 

https://support.office.com/en-us/article/trusted-documents-cf872bd8-47ec-4c02-baa5-1fdba1a11b53
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Add the Application Path to the trusted location 

 
 
 
 
 

7.5.4 Protect each sheet 
 
After checking the Checkbox everey sheet in the Workbook will be protected by a 
password. 
 

7.5.5 Name of the export file with the following possibilities 
 
- Original name of the data file 
- User specific name with the following individual elements 
 

Element name Configuration 

Original file name $O 

Batch name $B 

Serial number $S 

Los number (batch) $L 

Day $DD 

Month $MM 

Year (two digit) $YY 

Year (four digit) $YYYY 

Hour $HH 

Minute $mm 



 

 
AdvancedReportV2   

 

 

 
19/60  

  

Second $SS 

serial-number/year of the file $C 

1. Group name $1 

2. Group name $2 

3. Group name $3 

4. Group name $4 

1. Batch comment $C1 

2. Batch comment $C2 

3. Batch comment $C3 

 
The file name can be individually arranged by joining the individual elements. Also firm 
indication can be inserted. Please you pay attention to use only windows conformer 
indications for the name designation. 
 
Examples: 
 

Configuration Result 

$YYYY$MM$DD_Hallo 20040715_Hallo 

$B_$YYYY-$MM-$DD DXBATCH_2004-07-11 

$1_$B group1_DXBATCH 

 
 
With set the hook in the field “rename source file” also renamed the original file with the 
same name elements. The file extension will be remaining. 

 

 

 
Note: 
Not every element will be supported by every file format. 
 

 
 
 

7.5.1 Excel Limit 
 
If “Excel Limit” is selected, it is no neseccary to install Microsoft Excel on the PC. 
To get the correct Report it is neseccary to know the restriction of this solution. 

- An Excel Template within the format Microsoft Excel 2007 or 2010 
- Only ”*.xlsx” File extion is allowd 
- Formulas like SUM() are allowed in the Template 
- Charts are allowed in the Temaplte 
- Running a VBA Makro is not possible 

 
We use the “EPPlus” API for creation this solution. To get more information please check 
the URL: https://epplus.codeplex.com/ 
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7.6 Attitudes of alarms/messages 
 
On the register sheet alarms and messages are made the following attitudes: 
 

 
alarms and messages 

 
7.6.1 Defined starting line and starting column in the Excel file 

 
Check this option to insert the measurement values into the export sheet. If it not needed, 
uncheck this option for better performance. 
 

7.6.2 Selected channels define 
 
Here the channels intended for the export are indicated. By the entry „ALL “ all of the 
channels are spent. Each channel must with one beeps „|“ to be locked. The channels are 
sequentially spent in the order 1.2.3…. 
 

7.6.3 Selected period 
 
After checking only the selected period between the both time stamps will be report into 
the file. 
 

7.6.4 Further information into the export file insert 
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With the activating of the functions of alarms spend and messages spend, all alarms 
and/or messages stored in the data file are exported.  
Here two variants are supported: 

1. As export function for the measured values if the ASCII or Excel format is 
selected, the alarms and/or messages are likewise registered into the export file. 

2. If the export function Excel with collecting main is selected, an additional file is 
produced, this contains the alarms and/or messages. Also into this file the 
general data of the source file are registered. Here then the further fields 
become actively: 
A. Suffix to file name: The produced file receives the identical names of the 

measured value file with the registered extension. As default value the 
suffix is given „_AL_ML “. 

B. It is possible also here to define a collecting main file. 
C. It knows the initial position of the general data, to which alarms and the 

messages are indicated.  
 
7.7 DXP Audit Trail 
 
The operating announcements, the audit Trail, the dates of recorder DX100P and DX200P 
are inserted by the putting in the report file. All announcements are given since the last file, 
independently of the perhaps later measuring data recording. 
 

7.7.1 Signature Data DXP 
 
The signature data of the dates of recorder DX100P and DX200P are inserted by the 
putting in the report file. 
 

7.7.2 Graphic data  
 
The equipment files contain also graphic data/scale information, which can be merged for 
the analysis and representation of the measured values. These data are inserted in the 
measuring data file after activation. 
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7.8 Printer Settings 
 
On register sheet “Options” the following attitudes are made: 
 

 
Printer settings 

 
 
With activating this option, the provided files on a printer are spent. It is necessary to 
select a printer from the list. 
 

7.8.1 First printer 
 
As export format if the CSV format is selected, it is possible to define the printer 
orientation. 
 

7.8.2 Second printer 
 
To report the file to a second print format, check this option. 
Now it is possible to report the file into paper format and also into a PDF format. 
 
After checking the box “delete after creating report file” the report file will be delete.
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7.9 More Settings 
 
On register sheet “More settings” the following attitudes are made: 
 

 
More settings 

 
 

7.9.1 Freely defined entries 
 
The comments can be inserted up to four own firm. The entries are registered at the 
beginning of the target file. 
 
These entries are read in again before each report will be created. It is possible to change 
and so individually provide these entries by further programs 
 

7.9.2 Delete Files after x days 
 
This Function will be delete all data files within older than the defined days. Also the 
subfolder will be discovering for older files. 
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7.10 Attitudes automatic conversion 
 
On the register sheet the attitudes for the temporal interval of the conversion program will 
convert automatic transacted. At the selected time all data files in the listing are converted. 
The appropriate original files are likewise shifted into the goal listing. 
 

 

 
Note: 
Not every element will be supported by every file format. 
 

 
 

 
Note: 

1. If a new file should have been provided into the source listing in 
the time of the conversion, this is converted automatically in the 
next interval.  

2. Defective files are not converted. The export file is provided and 
contains a reference. 

 

 
With the hook in the field with Windows start AdvancedReport with each Windows start 
set. If the hook is deleted, the automatic start is deactivated.  
 
Automatic converting by an Icon in the system tray (beside the clock right down) is 
indicated. 
 

 
Icon System tray 
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The following time intervals are supported: 
 
1. Weekly 
Further attitudes necessarily: 
- Day 
- Hour  
- Minute 
 
2. Daily 
Further attitudes necessarily: 
- Hour  
- Minute 
 
3. Once per hour 
Further attitudes necessarily: 
- Minute 
 
4. Interval 
Further attitudes necessarily: 
- Minute 
 
Additionally the file extension of the data files must be stopped. Display data files can 
automatically be converted, display Event file or also both types. 
 
With the Button starting is activated automatic converting.  
 
A defective or manipulated file is recognized, with the export file with a reference is 
provided. Over the manual conversion, it is possible to try the receive data. 
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Auto conversion 

 
 
If the program is running as a service, it is not possible to start the program again. So save 
the settings, push the save Button. After stopping and restarting the software, the settings 
are available. 
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8. Attitudes manual conversion  

 
Over register sheet “manual convert” individual files with the selected format can be 
converted. 
 

 
Manual conversion 

 
Use the Button “open” to select one or more files. 
Create the report with the “create report” button. 
 
 

 

Notes: 
Also manual converting requires an existing target folder!  
Add the data files per Drag&Drop from the Windows Explorer into 
the file field. 
 

 
If the Option Detail Info is checked, there are more information about the actual 
conversion status is shown. Take care, it is an option, because it needs more time to 
create a report. The total conversion time will be shown after creating the report. 
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9. Starting parameter 

 
The program has parameters, which are read in when starting. 
 
The following parameters (COMMANDs) are available: 
 

Parameter  Function 

/AUTOSTART 
 

The program will be start automatically in 
scan mode.  

/PROJECT:<Reportname> 

 
Starts with a specific Project. To be use 
with command „/Source:“ 

< path > \ < filename >   identically to the parameter /Source: 
By using the parameter /Source: or 
/Target: this parameter will be ignore. 

/Source:<path>\<filename>  By indication of the file (*.dds/*.dev) this is 
converted with the current attitudes. The 
program is terminated immediately after 
the conversion. 

/Target: < path > \ < filename >  This parameter indicates the target folder 
and target name. 

 

 

 
Note: 
Not every element will be supported by every file format. 
 

 
 

 
Notes: 
It is used adjusted name. The data are converted however after the attitudes in 
the program. The file extension can be possibly wrong.  
 

 
Example: 
 
AdvancedReport.exe /Project:testcsv /Source:c:\11212010.DDS /Target:c:\exportdatei.txt 
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10. Attitudes automatic conversion  

 
 

 
Attitudes automatic conversion 
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11. Program Settings  

 

 

Settings Tab 1 

 
From the information dialogue the version number and the address become evident 
when questions and suggestions. 
 
11.1 License 
 

11.1.1 Serial number 
 
If the software in the demo version is installed, put the license number into these fields.  
With the Button save serial number the software is free licensed. 
 
 
 
 

11.1.2 Name 
 
Under name (company) the name of the enterprise is registered, if specific changes (e.g. a 
changed export format) at the software were made. 
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A serial number with the registered company name can be acquired at the company 
Yokogawa. 
 
 
11.2 Language change-over 
 
By the Button “language” the language change-over. After selecting a language, these 
select are directly switched. Please start the program again, in order to receive a 
complete language change-over. 
 
 

11.2.1 New language file provide 
 
It is possible to translate the program AdvancedReport into different languages.  
For the production of a further language, you proceed as follows: 
1. Copy the file english.lng from the installation folder into a temporary folder. 
2. Designate the file into the new language over, e.g. france.lng. 
3. Open the file and a changing you the texts behind the =-Sign. 
4. Store the file and copy them into the installation listing. 
5. The new language can be selected after a restart by AdvancedReport. 
 
 
11.3 Program protection 
 
Check this option to disable the following function. 

1. Save program settings 
2. End the program. 

 
By checking the checkbox “protect program control” and entering a password the save will 
be protected by the password. 
Also it is not possible to close the program without entering the password.  
 

 
Enter the password 

 
For saving the protection press the save button and re-enter the password. 
The protection mode will be displayed at the status bar on the bottom of the program. 
 
11.4 Service settings 
 
Please check for details also the installation manual. 
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Service Settings 

 
To convert the Data files within the Excel Template you must create a Folder 
under Windows 7 and Windows 8. 
 
IMPORTANT: Create the following Folder! 
 

64-bit %WinDir%\SysWOW64\config\systemprofile\Desktop 
 
And 
 
%WinDir%\System32\config\systemprofile\Desktop  

32-bit %WinDir%\System32\config\systemprofile\Desktop 

 

 

 
ATTESION IMPOTANT: 
It is only possible to create this folder as a user with administrative Rights! 

 

 
Path is required, if using Excel 

 
 

 
Service Settings as separate Application 
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Install the Service as User  

 
If the fields are empty, the service will be installed as “System” User. With this user it is 
NOT possible to use Excel. 
 
 

 
Counter of Software Instances 

 
It is possible to increase the conversion speed for the total counter of files. With this 
counter it will be convert data files parallel. 
Be careful with this parameter, the speed of another program can be slowly.  
The Service Status Window will be shown the actual action of the Windows service. 
 

 
Service Status Window 
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11.5 Logging  /Backup and Restor Settings 
 
Every important message is stored in the windows event log. With the pull down menu it is 
possible to select the logging rate. 
With default setting you will find only the important events in the Logfile. For more detail 
information within the error handling select the higher event log rate. 
 
Error Count Max:  
After 20 internal Errors, the windows service will be restart automatically. For this function 
it is necessary to start the service as a user with administrative rights. 
 
Termination Waiting Time [Minutes]:  
If the Software running as a service and a conversion of the report becomes an error, the 
conversion will be terminate after 10 minutes and also the Excel instance will be terminate. 
 
Export/Import Settings 
With this buttons it is possible to Backup and Restore the settings file 
 

 

Service Setting 
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12. Create Excel template 

 
By the report function it is possible to use all functions from the Office program MS 
Excel. 
For easy creating a template an Excel Add-In is installed with the Setup routine. 
The Add-In is automatically installed into the Excel Toolbar. 
 
 

 

NOTE: 
1. For a better performance delete all not used sheets about 

the file.  
2. Do not change the sheet order after creating the template.  

 

 

 
Start template creator with the Excel Button 

 
 

 
Toolbar with entry AdvancedReport 
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Two entries are indicated to submenu points. 
1. Create/edit template 
2. Help 
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12.1 Create template 
 
With operate the menu option ‘create template’ a window with the equipment 
information lights up. 
 
In this window all available information of the individual recorder are listed.  
 

 
Template 

 

 
Recorder Check 
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By the Pull down menu can be selected the appropriate type of recorder. 
The window which is under it is filled depending upon type with information.  
 
 

 

NOTE: 
Not each recorder has all information. Please check the options of 
the recorder. 

 
With the drag & drop functionality it is possible to insert the information into the Excel 
sheet. 
 

 
 

Drag & Drop 

 
The entry is marked by a small triangle in the upper rights corner. By that click the 
selection information field one lights up. 
 
 

 
NOTE: 
By reasoning and renewed open stand all entries to the recorder again to the 
selection. 
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12.2 Cell Definition 
 
The software checked the Cell Name to find the correct data for the Cell. 
Each Cell must be a unique name in the hole Excel sheet! If there are more than one 
point with the same Information, the Cell name must be a unique name like the format 
“adv1CH1data” and “adv2CH1data”. The info must be set to the end of the name 
 

 
 
 

12.2.1 The Cell Name format 
 
Measurement data: 
 
Channel KE

Y 
Channe
l No 

Value RESULT Recorder INFO 

Measuremen
t  

CH 1 data CH1data ALL Type Event File 

Measuremen
t  

CH 1 min CH1min ALL Type Event File 

Measuremen
t  

CH 1 max CH1max ALL Type Display File 

Measuremen
t  

CH 23 data CH23data ALL Type Event File 

Measuremen
t  

CH 23 min CH23min ALL Type Event File 

Measuremen
t  

CH 23 max CH23max ALL Type Display File 

       

Measuremen
t 

CH 0001 data CH0001data SmartDAC Event File 

Measuremen
t 

CH 0001 min CH0001min SmartDAC Event File 

Measuremen
t  

CH 0001 max CH0001max SmartDAC Display File 

       

Measuremen
t 

CH 001 data CH001data DX / DXAdv Event File 

Measuremen
t 

CH 001 min CH001min DX / DXAdv Event File 

Measuremen
t  

CH 001 max CH001max DX / DXAdv Display File 
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AdvancedReportV2   

 

 

 
41/60  

  

Mathematic Channel data: 
 
Channel KEY Channe

l No 
Value RESULT Recorder INFO 

Mathematic CH 1001 data CH1001data ALL Type  

Mathematic CH 1001 min CH1001min ALL Type  

       

       

Mathematic CHA 001 data CHA001data SmartDAC  

Mathematic CHA 001 min CHA001min SmartDAC  

       

       

Mathematic CH 101 data CH101data DX / DXAdv  

Mathematic CH 101 min CH101min DX / DXAdv  

       

       

 

 
SmartDAC GX / GP / GM Math Channel Value 

 
Communication Channel data: 
 
Channel KEY Channel 

No 
Value RESULT Recorder INFO 

Communication CH 2001 data CH2001data ALL Type  

Communication CH 2001 min CH2001min ALL Type  

       

       

Communication CHC 001 data CHC001data SmartDAC  

Communication CHC 001 min CHC001min SmartDAC  

       

       

Communication CH 2001 data CH201data DX / DXAdv  

Communication CH 2001 min CH201min DX / DXAdv  
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12.3 Add user defined VBA Makro 
 
After creating the report it is possible to run a Visual Basic for Application (VBA) Makro.  
The name of the Makro is AdvancedReport. 
 

 
VBA Editor for MS Excel 

 
Example: 
 
'Customer Makro 'AdvancedReport' 
Public Sub AdvancedReport() 
' 
'put your VBA code here 
    MsgBox "Hello, report finished", vbInformation, "YOKOGAWA AdvancedReport" 
End Sub 
 

VBA Makro 

 
 
12.4 How to Check, Change or Delete the Cell Name in Excel? 
 
To check all the correct Values implemented by the template creator, please use the 
following routine: 
 
It's easy to name a cell. You click on the cell, put the cursor in the "Name Box" to the left 
of the Formula Bar (see image below), type a name, and press Enter. Then you can 
reference that cell in other parts of the workbook. 
 
In the example below we have named the cell "Sub1" because we will reference this 
Subtotal in a Summary worksheet. 
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Cell Name 

 
 
However, after naming a cell, it seems like Excel won't let you delete or change the 
name! If you click in the Name Box and type over the name or delete the name, nothing 
happens! The name remains. 
 
So, how do I change a cell name? How do I delete a cell name? It's pretty easy ... it's 
just hidden! 
 
To delete or change a cell name, click the Formulas tab. Then click Name Manager on 
the "Defined Names" group of the Formulas ribbon. 
 
The Name Manager window displays and lists ALL of the cell names that have ever 
been defined in the worksheets in that workbook. 
 
To delete a cell name, click on the cell name and click Delete button. 
 
To change a cell name, click on the cell name, click the Edit button, Change the name 
and click OK. When finished, click Close. 
 

http://3.bp.blogspot.com/_1hGySniOTlw/TQANmgWTNkI/AAAAAAAAAw8/gkhg5ThpVsA/s1600/cellname1.gif
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Not defined Cell Names. This cell names can be delete 

 
 
12.5 Template Creator is not available 
 
If Excel starts correctly, but the Ribbon isn’t available, please check the following 
settings. 
 

 
1. Enable the Template Addin 
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Add the Application Path to the trusted location 

 
Open the Trust Center: 
 
File → Option (at the left bottom) →  

Trust Center (1) → Trust Center Settings → Trusted Location →  
 Add new Location (2)→  

Browse the AdvancedReportV2 installation folder →Select OK → 
   Close all Windows with OK 
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13. Run Program as NT- Service 

 
It is possible to start the program as a service. With this it is not necessary to login on 
the computer. It starts automatically with Windows. 
 

 

 
Note: 

• Also the FTP Server has to run as a Service! 

• All Settings have to be made as User with administrative Rights 
 

 
13.1 Installation 
 
Change to the Settings register. The Button „Install“ add the service 
„AdvancedReportSvc“ into the control panel. The Button „Start“ activate the Service. 
The service start as „System“ User in Automatic Mode.  
By changing the settings, it will be activate with a new folder scan. 
 

 
Install Service in AdvancedReport 

 
The messages are sending to the Windows event logger (Control Panel → 
Administrative Tools → Events). 
 

 

Windows Services 
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Add User Name to the Service 

 
To convert the Data files within the Excel Template you have to create a Folder 
under Windows 7 and newer. 
 
IMPORTANT: Create the following Folder! 
 

64-bit %WinDir%\SysWOW64\config\systemprofile\Desktop 
And 
%WinDir%\System32\config\systemprofile\Desktop  

32-bit %WinDir%\System32\config\systemprofile\Desktop  
 
 

 

 
ATTESION IMPOTANT: 
It is only possible to create this folder as a user with administrative Rights! 

 
With Version 2.7 und newer the service will be restart after an Error Counter of 10. 
For this function it is important to start the service as an user with administrative 
rights. 
 

 

 
ATTESION IMPOTANT: 
It is important to start the service as a user with administrative rights.  

 
 
 
13.1 Deinstallation 
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Change to the Settings register. The Button „Stop“ stopped the service. After stopping 
the service it is possible to uninstall the service by using the button „Un-Install“.  
 
 

14. AdvRptEnable Software to Enable/Disable a Report 
 
 
For an easy handling to enable or disable a report temporary use the installed Software Application 
“AdvRptEnable.exe”. This Application is installed at the Installation Folder, eg. “C:\Program Files 
(x86)\AdvancedReportV2”. 
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15. Error handling 

 
15.1 Solve Problem by yourself 

If an error is recognized in the conversion or in general running of the program, this is 
indicated by an “Alert window” and registered in the error log.   
 

 

Note: 

1. Please read this chapter to solve the problem.   

2. Use the Error Handling routine before calling your Services 
Team. 

 
 
 
15.2 Software AdvancedReport  
 
During the conversion or in the generally running program if an error is recognized, this 
is indicated by a reference display window and registered in the file error.log. 
Please send the file with exact error report and if necessary, the file which can be 
converted to the well-known email address. 
If the programs running as a Service, the messages are also sent to the Windows event 
logger (Control Panel → Administrative Tools → Events) 
➢ Start AdvancedReportV2 
➢ Select Button >Events<  See next picture. 

 

 
Start Error Handling routine 
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15.3 Software Template Creator Excel Addin 
 

 “I installed my Office solution (VSTO add-in) successfully but when I open the 
Office application, my add-in does not load. What is the problem?”  

This is a common question which I came across many times in Forums. Here are simple 
and quick checks that you can do before you start scratching your head or jump to the 
Forums. I’ll be using Excel as the Office application, but the approach is applicable to 
others more or less. 

15.3.1 Check out “COM Add-Ins” dialog in Excel 

Now open Excel and see if your add-in loads successfully. If not, open Excel Options 
dialog (File->Options) and navigate to Add-Ins tab.  

 

 

“Healthy add-ins” show up as “Active Application Add-ins”, however, if an add-in is 
disabled for whatever reason, it will appear under the “Inactive Application Add-ins”. You 
can select the “COM Add-ins” from the Manage dropdown at the bottom of this dialog and 



 

 
AdvancedReportV2   

 

 

 
51/60  

  

see the LoadBehavior of all COM add-ins. In normal cases, the add-in should be checked 
and its "Load Behavior" should be “Loaded at Startup”: 

 

 

If the VSTO runtime encounters a problem loading the add-in, you’ll see this message 
instead. 

“Load Behavior: Not Loaded. A runtime error occurred during the loading of the COM Add-
in”. 
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Add the Application Path to the trusted location 
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ActiveX Settings 

 

 
Makro settings  
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15.4 Excel Template and running as Service ( DCOM COMException 

(0x80080005) 
 

 “mod_main.Main 

Error line: 120 

System.TypeInitializationException: The type initializer for 
'AdvancedReportV2.mod_convertexcelmain' threw an exception. ---> 
System.UnauthorizedAccessException: Retrieving the COM class factory for 
component with CLSID {00024500-0000-0000-C000-000000000046} failed due to the 
following error: 80070005 Access is denied. (Exception from HRESULT: 0x80070005 
(E_ACCESSDENIED)).”  

 
OR: 
 

System.Runtime.InteropServices.COMException (0x80080005): Retrieving the COM 
class factory for component with CLSID {00024500-0000-0000-C000-000000000046} 
failed due to the following error: 80080005 Server execution failed (Exception from 
HRESULT: 0x80080005 (CO_E_SERVER_EXEC_FAILURE)). 

 at 
System.Runtime.Remoting.RemotingServices.AllocateUninitializedObject(RuntimeT
ype objectType) 

 
If you get this Error messing in Windows Event Log, please check the following security 
settings: 
Here is this solution 2: 

- In DCOMCNFG, right click on the My Computer and select properties.  
 

 
DCOMCNFG → “Microsoft Excel Application” → Context Menu → Properties 
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- Choose the General tab. 

 
General → set Authentication Level == None 
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Location → Check “Run application on the computer where the data is located” 

 

 
Security → Launch and Activaten Permisson → Add Administrors 

➔ Allow all settings for  
a. All Local Service / Administrators / INTERACTIVE 
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Security → Access Permisson → Add Administrors and Allow all settings 

➔ Allow all settings for  
a. All Local Service / Administrators / INTERACTIVE 

 

 
Security → Configuration Permisson → Add Administrors and Allow all settings 

➔ Allow all settings for  
a. All Local Service / Administrators / INTERACTIVE 
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Identity → The Interactive user 

 
 
 
15.5 Microsoft KB articles on general Excel troubleshooting 

• Excel: How to Troubleshoot Crashing and Not Responding Issues with Excel -
 https://support.microsoft.com/en-us/kb/2758592 

• Excel: How to troubleshoot crashing and not responding issues in an Excel Files -
 https://support.microsoft.com/en-us/kb/2735548 

 

Microsoft is quite explicit about not expecting any access to the COM object model from 
either the function wizard, or an .xll worksheet function (async or not): (used to be 
at https://support.microsoft.com/en-us/kb/301443 but now sadly no longer available...). 

"A function that is defined in an XLL can be called under three circumstances: 
 
1. During the recalculation of a workbook 

https://support.microsoft.com/en-us/kb/2758592
https://support.microsoft.com/en-us/kb/2735548
https://support.microsoft.com/en-us/kb/301443
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2. As the result of Excel's Function Wizard being called on to help with the XLL function 
3. As the result of a VBA macro calling Excel's Application.Run Automation method 
 
Under the first two circumstances, Excel's Object Model does not expect, and is not prepared for, incoming 
Automation calls. Consequently, unexpected results or crashes may occur. 
 
In order to ensure that they function properly, no Automation calls should be made from an XLL. Instead, all 
commands to Excel from the XLL should be sent using the Excel4() C API."  
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16. Appendix 

 
16.1 Reporting Deactivation and activation 

 
To deactivate a reporting temporary you will find two files at the installation folder. 
 

• ENABLE_Reporting.vbs 

• DISABLE_Reporting.vbs 
 
At these files you have to set the Report Project Name. 
 
If the reporting is deactivated, the new data files will be move to the target file 
destination. So the software will be work, but no report is created. 
 
 


